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Quick Start Guide 

Install and Authorize Your new Plugin: 

Double-click the .pkg (Mac) or .exe (Win) file. 

Follow the installation instructions. 

Open the plugin in your DAW of choice, enter your license code and click on 

ACTIVATE. 

 

For more information, please visit: www.dear-reality.com 

 

System Requirements and Supported Platforms 

Supported sample rates: 

44.1, 48, 88.2, 98, 176.4 and 192 kHz 

Supported Buffer Sizes:  

128 Samples or higher 

For latest System requirements & Supported Platforms, please check the product on our 

website.  

https://www.dear-reality.com/
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1 Introduction 
Thank you for purchasing our dearVR PRO 2 Plugin and welcome to the next step of immersive 

audio production. With the dearVR 3D audio technology you are able to design fantastic new 

music mixes for headphones or create deep auditory worlds and sound design within your 

DAW. 

This manual will help you understand the dearVR PRO 2 Plugin and how to use it in your 

projects. 

 
Important Note: 

dearVR is a 3D audio technology for headphones. Any kind or brand will do, but if the output 

format is set to “Binaural”, you have to use a headphone for the plugin to work properly. Please 

check that your left and right earpieces are properly placed and let’s get started… 

Have fun!  

 

 

1.1 About Binaural 3D Audio 

Binaural 3D Audio is a technology that simulates the human spatial hearing via headphones. 

If you listen to common stereo audio with headphones, the perception of all sound sources is 

located inside your head - between your left and your right ear. With 3D Audio you get the 

sound outside of your head where it belongs. A sound appears to emanate from a specific 

point - anywhere within a full 360° three-dimensional sphere. 

This gives you the ability to position a sound object all around the listener - behind, in front of, 

to the right or to the left of and even below or above.  

The quality of a 3D Audio rendering process depends on many factors - primarily the shape of 

our body, our head, and our ears. That’s why a mix with 3D Audio can sound different to 
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different people. Our uniqueness as human beings is actually a limitation for practical 3D 

Audio technology.  

Another typical problem that occurs with binaural 3D Audio is the front-back confusion. Our 

natural hearing uses small micro-movements of our head to optimize the localisation of a 

sound source. The head tracking technology, which is part of virtual reality devices, offers a 

solution to this problem. 

 

 

Illustration 1.1 - Full 360-degree 3D audio sphere 

 
Binaural 3D Audio is not made for listening via stereo speakers. Although in general the 

playback is possible, you will have to face strong colorations of the sound depending on 

your playback system. The reason for this is crosstalk, meaning a large portion of the left 

speaker signal will also go to the right ear of the listener. Similarly, a large portion of the 

right speaker signal will go to the left ear of the listener. With headphones this is different: 

both the left and the right channel signal reaches its respective ear. 
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1.2 dearVR CORE Engine 

All dearVR spatializer plugins rely on the advanced dearVR CORE engine, resulting in best-in-

class externalization and true-to-life immersion. For this, we listened back to our modelling 

technology over and over again and tweaked every parameter with our own ears. 

The acoustic modelling of an environment needs more than just 3D spatial location. It 

combines distance, motion, reflections and reverb to complete a simulation of an acoustic 

scene. 

All these phenomena can now be utilized for your sound design with just one plugin. 

Benefit from the highest spatialization quality with the dearVR CORE engine! 

 

 

 

2 Overview dearVR CORE Engine 
The dearVR PRO 2 Plugin is a 3D audio processor, enabling you to virtualize many different 

kinds of three-dimensional acoustic settings within your mix with a great amount of realism. 

The virtualisation of an acoustic environment with object-based sound sources refers to 

combining 3D spatial location cues with distance, motion, and ambience. All these parts are 

needed to achieve a realistic simulation of an acoustic scene - far beyond simple 3D 

positioning. 

For this reason, the dearVR CORE engine combines object-based 3D positioning with real 

time generated reflections depending on the room positioning and late diffuse reverberation. 
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2.1 Reflections 

A signal being reflected once or twice from parts of a listening space - walls, ceilings and floor 

- arrives shortly after the direct signal at the listener’s position. Such early reflections can be 

seen as a transition period before the reverberant field has built up. 

First reflections are responsible for our impression of the general character and the size of a 

room. These reflections are of great importance in binaural rendering in order to create a 

realistic localisation and the impression of sounds coming from outside of your head. 

Early reflections can be modelled by considering acoustic boundaries as acoustic mirrors. 

Depending on the listener’s position in a room and his/her distance to the boundaries, the time 

a reflection takes to arrive at his/her ears varies. Reflections also vary depending on the 

position of the sound source in the room. 

 

 

2.2 Reverb 

Reverb itself is an extremely complex reflection and diffusion pattern that builds up to a dense 

thickness from the moment you hear the original dry sound. For the dearVR CORE engine we 

captured the acoustic characteristics of different rooms or locations. The dearVR PRO 2 

plugin contains a selection of 46 virtual acoustics for spatial audio production. You can easily 

adapt these reverb characteristics for your mix by changing the reverb size or applying a 

reverb filter. 
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3 Control Panel 

 
Illustration 3.1 - Overview processing units 

 

The dearVR PRO 2 plugin is made up of four processing units: 

1. Position 

2. Reverb 

3. Reflections 

4. Master 

 

The signal flow starts in the Position Module, passes through the Reflections and Reverb 

sections and ends with the Output Format in the Master Module. Each module has a Gain 

controller before the signal enters the following section. 

  

1 
1 

2 

3
2 
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3.1 Position 

The Position module renders distance, listening angle and elevation relative to the listener. It 

is possible to enter values as Polar or Cartesian coordinates. 

Important: Azimuth, Distance and Elevation sliders (Polar Coordinates) are   

  only active in Polar Mode (see 1 – Input Mode) 

 

 
 

Illustration 3.2 - Position module 

 
1 - Input Mode 
 
 

Use toggle to switch between Cartesian or Polar Mode. 

 

1. Cartesian Mode 

Cartesian Coordinates X, Y, Z represent distances from the listener. 
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Illustration 3.3 - Cartesian Coordinates 

In Cartesian Mode, change position by dragging the audio source 
icon with the mouse in the XYZ-Pad. You can also enter numeric 
value into the XYZ display field. 

 

2. Polar Mode 

Azimuth and Elevation parameter describe an angle in degree, 

whereas Distance is set in meter (length of vector r) 

 
Illustration 3.4 - Polar Coordinates 

 

In Polar Mode, change position with the Azimuth, Elevation and 
Distance sliders. You can also enter numeric value into the display 
fields next to the sliders. 

Note: It is not possible to drag the audio source icon with the 
mouse while being in Polar Mode. A red position marker together 
with the note “POLAR” will appear. 



 

 
 
 

 13 

 
Illustration 3.5 - XYZ-Pad input disabled 

2 - Azimuth  
 

Set Input Mode to Polar and use the Azimuth Slider to enter the 
left/right position in degrees (+/- 180°). 
Use display next to the Azimuth slider to enter numeric values. 

Note: Slider is disabled if Input Mode is set to Cartesian! 

3 - Elevation 
 

Set Input Mode to Polar and use the Elevation Slider to enter the 
object height in degrees (+/- 90°). 
Use display next to the Elevation slider to enter numeric values. 

Note: Slider is disabled if Input Mode is set to Cartesian! 

4 - Distance  Set Input Mode to Polar and use the Distance Slider to enter the 
object distance (max. 30 meter). 
Use display next to the Distance slider to enter numeric values. 

Note: Slider is disabled if Input Mode is set to Cartesian! 

5 - Gain 
 

Sets the level of the audio source direct signal - independent of 
reflections and reverb gain. (-96dB ⇔ +24dB) 

Note: Values for direct, reflection and reverb levels influence the 
distance perception. 
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6 - Azimuth Scale Scale the internal dearVR horizontal-angle processing. 
Values: (0.2 ⇔ 4.0) 

Note: 
Value < 1.0 results in more sideways position perception. 
Value > 1.0 results in more centred position perception. 

7 - Distance Scale Multiplier for the internal dearVR distance processing. The 
processed distance is calculated by distance * distance scale. 
Values: (0.01 ⇔ 10.0) 

Note: 
Value > 1.0 lead to an increased distance perception.  
Value < 1.0 lead to a decreased distance perception. 

8 - Occlusion Acoustic occlusion describes the alteration within a sound field if 
the sonic wave is blocked by an object or wall. Occlusion Knob sets 
the level of occlusion if a sound source is occluded by an object. 
Values: (0.0 ⇔ 1.0) 

9 - Zoom +/- Use plus / minus buttons to zoom In or Out. 
There are six different zoom stages: 
3m / 6m / 12m / 18m / 24m / 30m 

10 - Display Mode  
(X/Z  Y/Z  X/Y) 
 

Switch between three different Display Modes: 

X/Z is a top view. 

Y/Z is a side view. 

X/Y is a rear view. 

Note: The Icon in the middle of the Display gives a quick overview 
of the chosen mode. 

11 – Stereo Width If dearVR PRO 2 is inserted on a stereo track, you can use the 

Stereo Width knob to alter the width. You will see two dots labelled 
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with L and R to visualize the position of the left and right channel. 

If the plugin is inserted on a mono track, the knob is greyed out and 

only the mono source is spatialized. 

In DAWs like Reaper, where there is no clear distinction between 

mono and stereo tracks, the knob won’t be greyed out ever. If you 

use a mono audio source, set the Stereo Width to 0. 

 

Tip – Shortcut Reset Position  

Press ALT and double-click into the XYZ display to reset the source position to default 

values.  

 
3.2 Reflections 

The reflections module generates reflection patterns depending on the sound source position. 

If the sound object moves, the reflection pattern adapts to the direction of the signal. 

With Realtime Auralisation, it is possible to create real-time reflections depending on the 

sound source position and distance relative to six walls: Left, Front, Right, Top, Back, Bottom. 

Walls are indicated within the XYZ-Pad using narrow lines. 

 

 
Illustration 3.6 - Reflections Module 
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1 – Wall Distance  
 

Listener’s distance to the ceiling / ground in meter 

Listener’s distance to the front / rear wall in meter.  
Value modifies delay and level of reflexion from front / rear 
direction. 

Listener’s distance to the left or right wall in meter.  
Value modifies delay and level of reflexion from left / right 
direction. 

2 - Reflections Gain 
 

Adjusts the overall gain of the reflections section. 

Values (-96dB ⇔ +24dB) 

3 - Reflections High 
Pass 

Applies a high-pass filter to the reflections. 

Set frequency values between 20 Hz to 20000 Hz.  

4 - Reflections Low 
Pass 
 

Applies a low-pass filter to the reflections. 

Set frequency values between 20 Hz to 20000 Hz.  

5 - Reflections 
On/Off  
 

Switch to turn ON/OFF the reflections rendering. 

 

6 – Realtime 
Auralisation 
 

Activates real-time processing to generate first reflections 
corresponding to the listener and sound object position relative to 
the chosen wall distances. 

Value 0 means no boundary. 
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3.3 Reverb 

For the reverb module we created 46 Virtual Acoustic presets, capturing the characteristics 

of different rooms and locations. You can easily adapt these acoustics to a specific scene or 

room by changing the size or applying the damping filter. 

 

 

 

Illustration 3.7 - Reverb Module 

1 - Preset 
 

Menu to select different Virtual Acoustic room presets. 

For an overview and detailed description of all presets see chapter 
4. Preset List. 

2 - Size 
 

Slider to decrease the reverb time of the selected preset. 
Values (50% ⇔ 100%) 

3 - Reverb Gain 
 

Adjusts the overall gain of the reverb section. 

Values (-96dB ⇔ +24dB)  

4 - Reverb High Pass 
 

Applies a high-pass filter to the reverb. 

Set frequency values between 20 Hz to 20000 Hz.  

5 - Reverb Low Pass 

 

Applies a low-pass filter to the reverb. 

Set frequency values between 20 Hz to 20000 Hz. 

6 - Reverb On/Off  Switch to turn ON/OFF the Reverb rendering. 

 

6 
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4 Master 
The Master module is responsible for defining input, output and general options like bypass 
and performance mode. 
 

 

Illustration 3.8 - Master Module 

 

1 - Output Format 
 

Select Output Format: 

We provide 34 different output formats for you so you can select 
the perfect one for you. There is the binaural option, 6 Ambisonics 
formats and 27 multichannel formats for you to choose from. You 
can find the different channel layouts for each format in the 
appendix. 

2 - Master Gain 
 

Sets the overall output gain. 

Values (-96dB ⇔ +24dB) 

3 - LFE Sets the LFE output level when using a multichannel configuration 
with an LFE. 
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4 - Clarity Clarity is an algorithm by Sennheiser Ambeo, which lets you control 
the amount of HRTF influence on the frequency response that is 
being applied to your binaural output signal.  The Clarity feature is 
only available in binaural output mode. 
 

Note: 
Value 0: maximal localization and externalization 
Value 100: minimal colorization of the HRTF, but less stable 
localization and externalization 

 

 
     Illustration 4.6 – Clarity Visualization 

 

Note: 
For our spatialization several HRTFs are used. As a graphical 
simplification only one HRTF is shown in the visualization of the 
Clarity feature. 
 

5 - Bypass Bypass all dearVR processing. 

6 - Bass Boost 
 

Enable bass enhancement on the input signal. 
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7 - Performance 
Mode 
 

Use Performance Mode for static, non-moving audio sources, to 
reduce processing load. 

Note: Only enable for non-moving objects. Moving the audio source 
while Performance Mode is active might cause glitches. 

8 - Head Tracking 
 

Signal LED is illuminated if Head Tracking is controlled by dearVR 
SPATIAL CONNECT software or a third party headtracker. For more 
information see chapter 9 in this manual. 
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5 Spatial Audio Formats 
 

Our plugin dearVR PRO 2 offers three different kinds of 3D audio formats: 

1. Binaural 

2. Ambisonics 

3. Multichannel 

 

To give you an overview about when to use which one, we briefly describe how they work 

and what kind of setup an end user needs to listen to the formats. In the following chapters 

you will find examples on how to use our plugin with each workflow. 

 

 

5.1 Binaural 

In our introduction we already covered a lot about binaural audio. The essence is, that 

binaural audio is ONLY working when listening to it on headphones. It is a two-channel audio 

format and therefore the workflow is as if you would make a stereo mix. 

 

 

5.2 Ambisonics 

The Ambisonics format is a more abstract one. Without going into the technical details, the 

most important details are that there are multiple orders of Ambisonics. The higher the 

order, the better the resolution of the 3D audio space. With the orders, the channel count 

also grows, starting at 4 channels for 1st order and going up to 9 and 16 channels for 2nd and 

3rd order. When mixing in Ambisonics, an Ambisonics decoder is necessary to listen to the 

mix (e.g., our plugin dearVR AMBI MICRO). The end user would also need an encoder for 
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his/her setup to listen to the mix. Facebook and Youtube already offer a native 1st order 

Ambisonics support and convert it back to binaural 3D audio. 

 

 

5.3 Multichannel 

dearVR  PRO 2 has the capability to encode lots of 3D audio speaker setups, starting from 

well-known cinema formats (e.g., 5.1, 7.1) and going up to 9.1.6 or 13.1. The end-user would 

need such a speaker setup to listen to your mix, which might be in a cinema with such a 

system or a bigger multichannel control room. If you don’t have such a big studio to mix in 

we also offer our plugin dearVR MONITOR which you can use to listen to your multichannel 

output on headphones using binaural 3D audio. 

 

5.4 Dolby Atmos 

In Dolby Atmos there is a distinction between the Dolby Bed, which uses a channel-based 

workflow, and Audio Objects, which additionally use meta-data. dearVR  PRO 2 can be used 

to encode tracks for the Dolby Bed. It is not possible to write meta-data with dearVR PRO 2, 

and hence it can’t be used for the spatialization of audio object.  

Atmos can be decoded different speaker setups and accordingly the format of the Dolby 

Atmos bed changes. If you don’t have a multi-speaker setup in your studio, you can use 

dearVR MONITOR to listen to your multichannel output on headphones using binaural 3D 

audio. 
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6 Binaural Workflow 
 
Since the Binaural workflow is very similar in all DAWs, we will describe this once with 

Reaper as an example. 

 

1. Create a track and put an audio file on it. 

2. Load dearVR PRO 2 plugin on the track 

3. Position your sources, add reverb and reflections 

4. Sum all binauralized stereo signals on one stereo bus 

5. Listen to that bus with headphones. 
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7 Ambisonics Workflow 

7.1 Pro Tools 

1. Create a mono/stereo track. Add dearVR PRO 2 plugin (FX category “Reverb”) with 

(Mono/stereo to Ambisonics 1st/2nd/3rd order) to the track. 

 

2. Head to Setup → I/O… , add a new path and create a new Aux track (1st / 2nd / 3rd Order 

Ambisonics). 
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3. Route dearVR tracks output to the Ambisonics bus. 

 
 

Notice 

To monitor the Ambisonics bus with headphones please check out the dearVR AMBI 

MICRO plugin at www.dear-reality.com  

 

  

http://www.dear-reality.com/
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7.2 Cubase 13 / Nuendo 13 

1. Head to Studio → Audio Connections and create an Ambisonics-Bus by clicking Add 

Bus and choosing e.g., 3rd Order Ambisonics in Configuration. 

 

2. Right-click your new Ambisonics Bus and click specify it as the Main Mix. The 

Ambisonics Bus should now appear in a red color in your Audio Connections. 
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3. Close the Audio Connections Window and create a new track with mono or stereo 

configuration. Select your Ambisonics Bus under Output Routing. 

 
4. Right click on the Panner field of Nuendo and select dearVR PRO 2 from the dropdown 

menu: 

 

5. For every new track, just repeat steps 3 and 4 or duplicate your audio track. 

Notice 

To monitor the Ambisonics bus with headphones please check out the dearVR AMBI 

MICRO plugin at www.dear-reality.com 

If using dearVR PRO 2 with binaural output, please use the insert effects slot on a stereo 

track! 

http://www.dear-reality.com/
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7.3 Logic Pro X 

1. Head to File → Project Settings → Audio and choose Quadraphonic as your Surround 

Format 

 

2. Create a new audio track and set the Output to Surround 

 



 

 
 
 

 29 

3. Add the dearVR PRO 2 Audio Unit as an insert effect and choose FOA YouTube or FOA 

FuMa in the Output section. 

4. For every new track, just repeat steps 2 – 3 or duplicate your audio track 

 

Notice 

To monitor the Ambisonics bus with headphones please check out the dearVR AMBI 

MICRO plugin at www.dear-reality.com  

 

 

  

http://www.dear-reality.com/
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7.4 Reaper 

1. Configure your master to have as many channels as you need for your Ambisonics 

format by clicking on Route on the master channel. 

 

 

2. Create a new track and additionally change the number of track channels to the 

number of the channels your Ambisonics format uses. 

 

 

3. Put dearVR PRO 2 on the track and select your Ambisonics format in the plugin as 

output. 

4. For every new track with an Ambisonics output repeat steps 2 and 3. 

 

 



 

 
 
 

 31 

Notice 

To monitor the Ambisonics bus with headphones please check out the dearVR AMBI 

MICRO plugin at www.dear-reality.com  

 

http://www.dear-reality.com/
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8 Multichannel Workflow 

8.1 Pro Tools 

1. Create a mono/stereo track. Add dearVR PRO 2 plugin (FX category “Reverb”) with 

mono/stereo as input format to your preferred multichannel output format to the track. 

 

2. Head to Setup → I/O… and create a new bus or output with your preferred multichannel 

format. 
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3. Select the configured multichannel format as output format in dearVR PRO 2. Route 

dearVR tracks output to the multichannel bus or output. 
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4. For every new track, just repeat steps 2 – 3 or duplicate your audio track.  
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8.2 Cubase 13 / Nuendo 13 

1. Head to Studio → Audio Connections and create a bus with your preferred multichannel 

output configuration by clicking Add Bus and choosing, e.g. 5.1. 

 

2. Right-click your new multichannel bus and specify it as the Main Mix. The 

multichannel bus should now appear in a red color in your Audio Connections. 
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3. Close the Audio Connections Window and create a new track with mono or 

stereo configuration. Select your multichannel bus under Output Routing 

 
 

4. Right click on the Panner field of Nuendo and select dearVR PRO 2 from the 

dropdown menu. Inside the plugin choose the output format you configured in 

Nuendo. 
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5. For every new track, just repeat steps 3 and 4 or duplicate your audio track. 
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8.3 Logic Pro X 

1. Head to File → Project Settings → Audio and choose your preferred Surround format 

 
 

2. Create a new audio track and set the Output to Surround. 
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3. Add the dearVR PRO 2 Audio Unit as an insert effect and choose the Surround format 

in the Output section. 

 

 

 

 

Notice 

The multi-channel speaker layouts of Logic are different from that of other major DAWs 

(especially Pro Tools). dearVR PRO 2 automatically adapts the channel order and 

speaker angles for Logic Pro.   
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8.4 Reaper 
 

1. Configure your master to have as many channels as you need for your multichannel 

format by clicking on Route on the master channel.  

 
 

2. Create a new track and additionally change the number of track channels to the 

number of the channels your multichannel format uses. 

 
 

 

3. Put a dearVR PRO 2 instance on the track and select your multichannel format in the 

plugin as output. 

4. For every new track with a multichannel output repeat step 2 and 3. 
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9 Head Tracking 

9.1 Basics 

Dear Reality products use the Open Sound Control (short OSC) protocol to communicate the 

position of your headphones in the form of Yaw, Pitch and Roll to our plugins. The protocol 

needs a sender, which is your OSC-capable headtracking device, and a receiver, which is the 

dearVR SPATIAL CONNECT Adapter. The Adapter can be installed together with dearVR PRO 

2. It then acts as a port to control all dearVR plugins. Thus, dearVR SPATIAL CONNECT 

Adapter has to run in the background, if you want to make use of the headtracking feature. 

Please make sure to open the adapter before your dearVR plugin. 

You can choose between two types of protocols in the Adapter: “OSC Headtracker” or 

“Spatial Connect”. Use “Spatial Connect”, if you want to connect to dearVR SPATIAL 

CONNECT and “OSC Headtracker”, if you want to use your third party headtracker. 

Follow the instructions in order to get started: 

 

OSC Headtracker 

Start dearVR SPATIAL CONNECT Adapter, set the Head Rotation Port to the port your device 

sends the headrotation data and choose the “OSC Headtracker” as Protocol. The logo of the 

SPATIAL CONNECT Adapter should state an ongoing connection, if your headtracker is 

sending OSC data. 

 

Spatial Connect 

Start dearVR SPATIAL CONNECT Adapter, set the Head Rotation Port to the port dearVR 

SPATIAL CONNECT sends the headrotation data (we recommend 7001) and choose “Spatial 

Connect” as Protocol. The logo of the SPATIAL CONNECT Adapter should state an ongoing 
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connection, if dearVR SPATIAL CONNECT is running. For more information about dearVR 

SPATIAL CONNECT, find the manual here. 

 

9.2 Step by step guide for the Supperware Headtracker  

We recommend the Supperware headtracker and its companion app “Bridgehead” that you 

can find here. But you can also use other headtrackers as long as those support OSC. 

1. Download and install the Bridgehead application by Supperware, if not already 

installed. Use “Bridgehead for Windows (64-bit)” or “Bridgehead for macOS”.  

2. Install the dearVR SPATIAL CONNECT Adapter. Just re-run the dearVR installer and 

choose dearVR SPATIAL CONNECT Adapter in the custom install section.  

For users with an Apple Silicon computer: If your DAW runs in Rosetta mode, please 

make sure to also run your dearVR SPATIAL CONNECT Adapter in Rosetta mode.   

 

Use  

 

1. Start Bridgehead, go to “OSC bridge settings” and choose “dearVR” as Profile. 

Connect your Supperware headtracker via USB.  

2. If the dearVR profile is not available yet, please update your bridgehead application 

or add the following to your Profiles.txt:  

3. Start dearVR SPATIAL CONNECT Adapter, set the Head Rotation Port to 7001 and 

choose the “OSC Headtracker” as Protocol. The logo of the SPATIAL CONNECT 

Adapter should state an ongoing connection, if your headtracker is sending OSC 

data. 

4. Open your DAW of choice, insert your plugin and you are all set!  

dearVR 
/ypr 
yaw,pitch,roll 
local 7001 

https://lm.dearvr.com/files/dearVR_SPATIAL_CONNECT_Manual.pdf
https://supperware.co.uk/
https://supperware.co.uk/headtracker
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5. The greyed out “HEAD ROTATION” knob should follow your head movement. If you 

are looking at the center of your monitor and the value of your “HEAD ROTATION” 

knob is not 0, please recalibrate your Supperware headtracker. 
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10  Atmos Workflow 
 
10.1  Nuendo 13 

 
1. Head to Studio → Audio Connections and create a bus with your preferred 

multichannel output configuration by clicking Add Bus and choosing, e.g. 7.1.4.  

 

2. Right-click your new multichannel bus and specify it as the Main Mix. The 

multichannel bus should now appear in a red color in your Audio Connections 
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3. Head over to the Group/FX - Tab and create a new group for beds with your preferred 

output configuration, e.g. 7.1.2. Select your new output-bus from Audio Outputs. 
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4. Close the Audio Connections window and load the Renderer for Dolby Atmos Plugin 

on your 7.1.4 main output bus. Set the Downmix to the format of your output bus. 

 

 

Notice 

You can use dearVR MONITOR to monitor your multichannel output bus with headphones. 

Please check out the plugin at www.dear-reality.com  

 

5. Head to Project → ADM Authoring… , select Dolby Atmos  as Format, click on Add 

Bed and select your new bed group as the source track. 

http://www.dear-reality.com/
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6. Create a new track with mono or stereo configuration. Decide whether you want to 

use the track as an audio object or as part of the Dolby bed: 

a.  Audio Object: Select your 7.1.4 bus under Output Routing. Go back to the 

ADM Authoring for Dolby Atmos and add your track as an audio object. You 

can’t use dearVR PRO 2 to spatialize audio objects in an Atmos mix. You are 

done with this track and can ignore the following steps.  

b. Bed: Select your bed group in Output Routing and continue with step 7. 
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7. Right click on the Panner field of Nuendo and select dearVR PRO 2 from the 

dropdown menu. Inside the plugin choose the format of your Bed Group, e.g. 7.1.2. 

 

 

8. For every new track, just repeat steps 6 and 7 or duplicate your audio track. 
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10.2  Logic Pro 

1. Head to File → Project Settings → Audio and set Spatial Audio to Dolby Atmos. Choose 

your preferred Surround Format multichannel configuration. 

 
 

2. Logic automatically inserted the Atmos plugin on your master track. Open it and 

choose your preferred monitoring format. 
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Notice 

You can use dearVR MONITOR to monitor a multichannel output with headphones. Please 

check out the plugin at www.dear-reality.com  

 

3. Create a new audio track and set the Output to Surround. Decide whether you want to 

use your audio track as an audio object or as part of the Dolby Bed.  

a. Audio Object: Right-Click on the Panner Field and select 3D Object Panner. 

dearVR PRO 2 can’t be used to spatialize audio objects in an Atmos mix. Your 

done with this track and can ignore the following steps. 

b. Bed: Add dearVR PRO 2 as an insert effect and choose the Surround format in 

the Output Section. 

  
 

 

 

  

http://www.dear-reality.com/
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11  Preset List 
Note: The larger a room the longer the reverb – and the more performance is needed! 

Performance Level (PL) illustrates the performance load within a range from 1-10. 

Level 10 needs the most performance. 

 

A. Rooms & Halls Room Size 

Auralization - Wall Distance (meter) 

LEFT   FRONT    RIGHT   TOP    BACK   BOTTOM 

PL 

Concert Hall 1 12,9m   14,0m   10,5m    20,8m    25,1m    1,8m 5 

Concert Hall 2 14,1m   16,6m   13,3m    21,5m    28,3m    1,8m 5 

Large Recording Hall  15,7m   12,1m   15,9m    22,2m    19,3m    1,8m 7 

Small Recording Hall 7,7m   5,4m   7,9m    12,0m    9,3m    1,8m 4 

Kings Hall 13,7m   10,4m   13,9m    20,3m    7,3m    1,8m 5 

Cathedral 27,5m   24,2m   29,0m    30,0m    30,0m    1,8m 10 

Church 13,9m   17,9m   11,5m    25,5m    22,1m    1,8m 5 

Chapel 14,7m   12,4m   14,1m    23,0m    16,3m    1,8m 8 

Large Room  7,9m   4,4m   6,9m    10,0m    5,5m    1,8m 5 

Medium Room 3,8m   2,1m   4,1m    4,0m    2,8m    1,8m 4 

Small Room 2,7m   1,5m   2,6m    3,6m    2,2m    1,8m 3 

 

 

 

  



 

 
 
 

 52 

B. Postproduction Room Size 

Auralization - Wall Distance (meter) 

LEFT   FRONT    RIGHT   TOP    BACK   BOTTOM 

PL 

Office 1 3,2m   1,9m   3,9m    4,5m    2,8m    1,8m 2 

Office 2 6,7m   2,4m   6,9m    5,3m    3,3m    1,8m 2 

Small Studio 2,7m   2,0m   3,4m    4,7m    2,1m    1,8m 2 

Medium Conference Hall 6,7m   3,4m   6,9m    7,0m    3,3m    1,8m 3 

Cellar 2,5m   2,8m   3,0m    3,2m    2,1m    1,8m 4 

Empty Room 5,0m   3,2m   3,7m    5,8m    4,3m    1,8m 3 

Small Livingroom  2,3m   3,1m   2,7m    2,9m    2,6m    1,8m 2 

Staircase 4,7m   3,5m   4,9m    8,0m    3,3m    1,8m 4 

Corridor 2,7m   2,0m   2,6m    8,8m    4,5m    1,8m 5 

Bathroom 2,1m   2,0m   2,3m    2,8m    1,6m    1,8m 3 

Restroom 2,7m   1,5m   3,2m    4,2m    2,3m    1,8m 4 

Car 1 0,6m   0,7m   1,7m    1,6m    1,9m    1,3m 1 

Car 2 0,5m   0,7m   1,0m    1,3m    1,6m    1,2m 1 

Booth 3,7m   2,1m   3,3m    2,5m    1,3m    1,8m 2 

Cinema 8,0m   7,0m   9,0m    14,0m    9,0m    1,3m 2 

Warehouse 12,0m   10,0m   8,0m    20,0m    15,0m    1,8m 10 

Outdoor Street 24,9m   0,0m   22,5m    0,0m    0,0m    1,8m 5 

Outdoor Alley 14,2m   0,0m   16,5m    0,0m   3,1m    1,8m 5 
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C. Music production Room Size 

Auralization - Wall Distance (meter) 

LEFT   FRONT    RIGHT   TOP    BACK   BOTTOM 

PL 

Studio Room  6,7m   3,4m   6,9m    8,0m    3,3m    1,8m 5 

Live Stage  11,7m   5,4m   11,9m   16,5m    14,3m    1,8m 7 

Live Arena 20,2m   17,0m   21,5m    25,0m    15,7m    1,8m 7 

Heavy Ambience 6,7m   3,1m   6,9m    8,0m    3,3m    1,8m 4 

Plate Ambience 6,7m   3,1m   6,9m    8,0m    3,3m    1,8m 3 

Medium Ambience 6,7m   3,1m   6,9m    8,0m    3,3m    1,8m 3 

Small Ambience 6,7m   3,1m   6,9m    8,0m    3,3m    1,8m 2 

Vocal Hall 1 20,2m   15,0m   21,5m    25,0m    12,7m    1,8m 7 

Vocal Hall 2 20,2m   15,0m   21,5m    25,0m    12,7m    1,8m 7 

Vocal Plate 20,2m   15,0m   21,5m    25,0m    12,7m    1,8m 8 

Drum Room 1 6,7m   3,1m   6,9m    8,0m    3,3m    1,8m 6 

Drum Room 2 2,7m   3,1m   2,9m    6,0m    4,3m    1,8m 6 

Percussion Plate 6,7m   3,4m   6,9m    8,0m    4,3m    1,8m 5 

Percussion Ambience 6,7m   3,4m   6,9m    8,0m    4,3m    1,8m 2 

Acoustic Hall 20,2m   15,0m   21,5m    25,0m    12,7m    1,8m 6 

String Hall 20,2m   15,0m   21,5m    25,0m    12,7m    1,8m 8 

String Plate 20,2m   15,0m   21,5m    25,0m    12,7m    1,8m 8 
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12 Multichannel Configurations 

The Multichannel Layouts are different between some DAWs. Different DAWs expect the 
speakers to be positioned on different room angles. The angles, which are listed here refer 
to Pro Tools unless otherwise noted. If loaded in Logic Pro, dearVR PRO 2 automatically 
adapts the channel order and room angles of the DAW. On other DAWs the results may and 
will vary if compared due to different multichannel layouts. 
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13 Troubleshooting / Known issues 
1. Minimum Buffer Size. 

A minimum buffer size of 1024 is recommended. 

 

2. Multichannel output for Ableton Live, FL Studio, Samplitude, Cakewalk, and other stereo-

only DAWs 

Due to restrictions within these hosts, no multichannel or Ambisonics outputs are available.  

 

3. Cubase/Nuendo behaviour for mono audio tracks 

Due to the internal routing of the Cubase/Nuendo mono track, the spatialization processing 

of dearVR PRO 2 is restricted. 

This issue arises when a mono -> stereo track is setup in Cubase/Nuendo and dearVR PRO 2 

is placed on an insert effects slot. To avoid this issue please always use dearVR PRO 2 with 

a stereo track in Nuendo/Cubase, even if you’re working with mono material. 

 

4. Legacy Incompatibility with Cubase/Nuendo panner slots 

Since the introduction of the Nuendo and Cubase Pro panner slots, dearVR PRO 2 no longer 

operates in the insert effects chain, when it’s being used to output Ambisonics. 

A Nuendo/Cubase session with dearVR PRO 2 placed in the insert effects slot is therefore not 

compatible with the new panner slot setup (except for binaural and 2.0 Stereo setup). 

 

6. Pro Tools user presets: 

If there are no user presets available, delete the dearVR PRO 2 folders in Pro Tools’ plugin 

settings. Reinstall the AAX component afterwards.  

WIN: C:\Users\<user>\Documents\Pro Tools\Plug-In Settings 

macOS: ~/Documents/Pro Tools/Plug-In Settings 
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7. dearVR PRO 2 does not appear in my DAW on Windows: 

dearVR PRO 2 does not appear in DAWs, when a Visual C++ Redistributable is missing. Try 

to install the “Microsoft Visual C++ Redistributable for Visual Studio 2015, 2017 and 2019 

Redistributabel (x64)” on your machine. You can find the package here: 

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-

downloads 

 

8. dearVR PRO 2 in Adobe Premiere 

dearVR PRO 2 can cause crashes in Adobe Premiere 2022. We recommend using the VST3 

version of the plugin, as it works best with Premiere. Due to an incompatibility issue there 

might occur crashes, when trying to close the application. Make sure to save all changes, 

before closing Adobe Premiere.  

 
 
  

https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-ca/help/2977003/the-latest-supported-visual-c-downloads
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14 Contact 

Support 

Please let us know if there are any questions concerning the dearVR Plugin. 
If you need further assistance, please send an email to: 
support@dear-reality.com 

For the latest news concerning dearVR please visit our website at: 
www.dear-reality.com 

 
 Dear Reality GmbH 
 Binterimstraße 8 
 40223 Düsseldorf 
 

 
Caution 
Using headphones requires responsible listening. Damage to hearing occurs when listen to 
loud sounds with headphones over time. 

- Set the volume control of your computer to a minimum when connecting your 
headphones. 

- Set the volume in a quiet environment and select the lowest volume at which you can 
hear adequately. 

- Do not turn the volume control to high, as this can cause permanent hearing damage. 
- Be aware that you can adapt to higher volume settings over time, not realizing that 

the higher volume may be harmful to your hearing. 

Dear Reality GmbH will in any event not be liable for any damage to hearing caused by loud 
sounds. 
 
 
 
dearVR Copyright © by Dear Reality GmbH. All rights reserved. 
All trademarks or registered trademarks are the property of their respective owners. 
No part of this documentation may be reproduced or transmitted in any form by any means, 
electronic or mechanical, without permission in writing from Dear Reality GmbH. 

mailto:support@dear-reality.com
http://www.dear-reality.com/
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